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REPORT	 BARACK OBAMA: LONG FORM BIRTH CERTIFICATE

Introduction Basics
Merely viewing the Long Form birth certificate in Acrobat reader—
without any special software—is enough to reveal a myriad of 
image tampering evidence. What do you look for?

Figure 1 is an example of a scanned image viewed in Photoshop. 
Notice that the Layers palette displays one layer which defaults 
to the name Background. A one layered file is also referred to as a 
flattened image (more on layers later).

Scanned images will have a consistent noise and/or grain. Any 
inconsistencies in noise or grain would be a strong telltale sign of 
tampering. Obama’s long form certificate document shows a clear 
inconsistency of noise in various locations. Let’s examine a scanned 
image to get an understanding of what is meant by the term 
noise—which is more easily seen at high zoom levels. Figure 1 
shows the sample zoom areas of focus—to get a closer look. 

Noise and Antialiasing
So what is noise? At the normal zoom level (100%) shown in 
Figure 1, there seems to be the normal transitions of color tones 
and shadows. For example, “Sample area one” appears to have a 
solid black area of hair near the face. Conversely, “Sample area two” 
(also shown in Figure 1) appears to have a solid white or off-white 
area.

However, when you zoom in closer as seen in Figure 2 (for area 
one) and peek ahead to Figure 3 (for area two), you can easily 
view consistent noise which is apparent in the slight variations of 
color from neighboring pixels. This is the natural noise level for 
this image, and it is consistent throughout the image. If necessary, 
zoom in for a closer look at Figure 2, and you can clearly see the 
consistent noise in the black tones as well.

Also notice the transition of pixel colors that occur when colors of 
contrast bump up next to each other—such as the edge of the face 
against the dark hair color. This is referred to as antialiasing which 
offers a smooth line of transition and gives the appearance of a 
smooth line (to the eye) when viewed at the normal zoom level of 
100% (in Figure 1). Without antialiasing, the edges appear jagged 
or bitmapped.

Noise v No Noise
Before applying this concept to Obama’s PDF certificate file, 
I would like to make another point using the same example 
image. Figure 3 shows a pixel that is sampled to match one of 
the off-white colors within the image: Using a paint brush tool (in 
Photoshop), a streak of the sample color was drawn across the 
image area.

Notice that a component added digitally to an 
image does not contain noise. All neighboring pixels 
for the sample paint stroke in Figure 3 is solid in 
color with no variation—not even the slightest of 
variations.

In order to avoid detection when editing 
an image, an experienced professional will 
attempt to mimic the noise to match the 
document. There are many methods, but 

the most common method would be to add Noise 
to the painted area via the Filter menu provided in 
Photoshop (shown in the menu figure to the left).

Figure 3:  Solid digital paint stroke added to image

Sample pixel color

Paint stroke with sample color

Figure 2:  Sample area zoom and noise becomes apparent 

Figure 1:  Photo Image at 100% Zoom Level

Layers panel reveals 
one layer

Sample area one

Sample area two
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Scanner Chromatic Aberration
The previous sections discussed noise and antialiasing in reference 
to a scanned photo, but what about scanned text? Figure 4 shows 
a sample section of scanned text. The Figure 4 insert shows the 
sample text at normal zoom level—The Anniversary Series—looks 
like ordinary black text. The majority of Figure 4 zooms into a 
couple of text characters for a closer look at 1400% zoom level.

Clearly a similar consistency in noise and antialiasing can be seen 
at the higher zoom level. Additionally, notice a pattern in the 
antialiasing transitional colors: The bottom or left edges of the text 
(as it transitions into the white background) are red-ish color values 
in this example, similarly there are consistently blue-ish color 
values around the top and right edges of transitions. This is typical, 
quite normal and is referred to as chromatic aberration—caused 
when different wavelengths of light are refracted differently as it 
goes through a lens or prism during the scanning process.

Applying Foundational Basics
Now let’s examine some sample areas of Obama’s Long Form 
Certificate in Acrobat. Again, no need for special image editing 
software at this point, just an understanding of what to look for.

Let’s start by mentioning that there is no evidence of chromatic 
aberration anywhere in the document—this is not normal and 
neither is the white halo surrounding the text—both points 
indicates image tampering (more on the halo later).

Figure 5 clearly displays numerous inconsistencies of noise 
and aliasing—also indicators of image tampering. A normal 
document—scanned and saved as a PDF—would not display these 
inconsistencies unless digitally altered and compiled.

It should be noted, that these inconsistencies alone refute the 
argument floating around that the layers can be explained by 
using OCR (Optical Character Recognition) software. OCR software 
would not generate an inconsistency in noise and aliasing. Not to 
mention, the ethical implications of using OCR software—which 
is to allow for the capability to edit text in a scanned document. 
So why would you choose to use OCR software when scanning an 
official document that is not intended to be edited or altered?

Figure 6 offers more inconsistency examples as follows:

ÂÂ Bitmap text versus antialiasing text—notice the bitmap 
X checkbox in question d compared to the antialiased X 
checkbox in question e—major inconsistency.

ÂÂ Additionally, the checkboxes are slightly different widths and 
positioned differently (pixels of checkbox on the bottom-right 
overlap line pixels below). It’s almost as if the boxes were 
copied and pasted and manually positioned.

ÂÂ Some letter characters are identical (pixel for pixel), almost like 
they were copied and pasted (and then moved into position). 
Example, the lowercase “i” in the word Inside is identical to the 
first “i” in judicial. There are many similar identical instances as 
there are dissimilar typesetting examples of different fonts—
both suggesting compilation of a document digitally.

ÂÂ Irregular typesetting spacing which is not consistent with 
proportional spacing used by computers or monospacing 
used by typewriters in 1961—but is consistent with copy and 
pasting and moving letters around. Example: The word “Yes” 
which has too much space between “Y” and “e” and not enough 
space between “e” and “s”.

Figure 5:  PDF LFCB viewed in Acrobat at 1200% zoom level

Noise inconsistency in 
background pattern

Noise inconsistency in line

Noise inconsistency in text as 
well as inconsistency in aliasing

Figure 4:  Scanned text and chromatic aberration

Figure 6:  Evidence of font typesetting inconsistencies

Inconsistent checkbox sizes, 
aliasing and proximity to the line

Font inconsistencies—serif at 
bottom of one “d” and not other

Another shift from solid 
bitmap to antialiasing 

Identical letters that suggest 
duplication such as with letter i 
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Figure 7:  Inconsistencies within signatures

Noise & aliasing differences for 
comma & K v surrounding text

Solid pixel parenthesis v 
noise pixel parenthesis? 

Figure 8:  Inconsistencies in pixel colors and spelling errors?

Spelling error on stamp? Really? 
So all official Hawaiian birth 

certificate documents should have 
the same spelling error—right?

Difference in text color 
compared to last digit 

Alvin’s signature suddenly 
develops a smiley face?

Figure 9:  http://factcheck.org/2008/08/born-in-the-usa/

Figure 7 once again demonstrates a trend of mixed solid 
bitmapped character elements combined with antialiased 
elements. It also seems apparent that typed text characters were 
altered whenever signatures overlapped or bumped against typed 
text characters. Additionally, signatures shows signs of being 
pieced together from multiple source documents.

Many of the adjustments are on separate layers—again, more 
on this later—but currently the focus is on what can be seen in 
Acrobat.

Differences in Text Color Values
Figure 8 shows two similar dates in which portions of the date 
were from different edited sources. Visually, this can be seen in 
the differences of text color. Look closely and you can clearly see 
dark black color for some digits (especially the last digit 1 in both 
instances), while other digits are a light gray.

It is only speculation, but my guess is that the creator of this 
document is inexperienced when it comes to a multitude of 
important concepts. The user might have known enough to be 
dangerous, but not enough to know how to cover his/her tracks.

In the printing world, you quickly learn that the object may 
appear as solid black on the monitor screen but not all blacks are 
created equal. After working in a printing department, and ripping 
files to a professional printer, you quickly learn to check for the 
quality of the black values to ensure consistency in black tones. In 
addition, Adobe has a setting that can prevent objects colored in 
pure black from being displayed as Pure Black or Rich Black. Not 
understanding this printing and typesetting concept is a common 
mistake made by beginners. And printing to a PDF is similar to 
ripping to a professional printer. So guess what? An object that is 
colored black on the monitor may not appear black when printing 
to a PDF. More evidence the document was digitally compiled?

On page 4 (the next page), I offer two web page captures of article 
links  provided in Figure 10 and Figure 11 (along with their 
URL’s). Figure 10 is from Adobe’s web help file and discusses the 
Mac settings for the pure black issue. Figure 11 offers an easy to 
understand explanation of the significance of pure black and rich 
black when printing.

Applying Common Sense
Not everything on Obama’s certificate document needs a 
professional analysis—you just need common sense. For example, 
all of us are often told that the first telltale sign of a fraudulent 
document or email scam is to look for misspellings. Wouldn’t 
that obvious concept apply to the official stamp that displays 
“TXE” (shown in Figure 8) rather than “THE” (shown in Figure 9)—
especially based on an assumption that such a stamp was 
supposedly used on multiple official documents?

Interestingly, Figure 9 shows an image of the same stamp 
displayed at Factcheck.org in reference to the short form certificate 
from 2008. The spelling error is absent along with a smiley face 
in the Alvin signature. It should be noted, that if a low resolution 
image (such as the one shown in Figure 9) was used as an added 
component for the long form document, the enhancing process 
could have been a possible cause or explanation for the final 
anomaly flaws. In fact, I believe that the enhancement process 
of low resolution text would explain the bitmapped quality of 
the text, the poor readability characteristics, as well as a possible 
explanation for the white halo effect surrounding the text.

No spelling error

Alvin’s signature 
without smiley face?
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Figure 10:  http://livedocs.adobe.com/en_US/Illustrator/13.0/help.html?content=WS7E8089AA-F584-46b0-8E67-DAA2ED79BE4B.html

Figure 11:  http://www.printernational.org/rich-black-plain-black.php

Information on Pure Black v Rich Black

http://livedocs.adobe.com/en_US/Illustrator/13.0/help.html?content=WS7E8089AA-F584-46b0-8E67-DAA2ED79BE4B.html
http://www.printernational.org/rich-black-plain-black.php
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More Questions
A few more items to consider are shown in the overall view of the 
document in Figure 12 as follows:

ÂÂ Why is there an odd excessive typesetting space between the 
number 4 and comma in the birth date?

ÂÂ “African” is not a race. Would “American” be a race? It may not 
be politically correct, but in 1961, the option for race would 
have been Negro—not “African” which is another odd artifact 
out of place with the context of the historical time and place—
an anachronism.

ÂÂ Speaking of anachronisms—in 1961, when typewriters were 
used, the typist would move to the next line, and items started 
in a standard left margin (unless the typist purposely tabbed 
over to a different location on the document). Thus most of the 
left margin text would consistently line up at the same point. 
Figure 13 is explained below, and can be used to compare the 
margin line text in the Nordyke certificate with Obama’s in 
Figure 12. Nothing is properly aligned in Obama’s document.

ÂÂ Figure 12 v Figure 13: If Obama was born the day before the 
birth date shown in Figure 13, then why would his certificate 
number be greater? Wouldn’t a smaller certificate number 
be consistent with the earlier birth date and the earlier Date 
Accepted (filed date)?

ÂÂ Where is the State seal? Who has an official birth certificate 
document that is missing a seal?

ÂÂ Why is there a background pattern? The Obama administration 
claims the pattern was added for security purposes—but isn’t 
that admitting to altering the document? Is the administration 
trying to create a frame of hiding the edits in plain site by 
saying “Yes, we edited the document to add security paper.” 
And why would this even be necessary?

ÂÂ Why would the date at the bottom of the document display 
different type fonts? The font used for the year is clearly a 
different font than the one used for the day. Under what 
circumstances would you change fonts while typing a date? 
Even if a stamp was used to stamp a date, wouldn’t the stamp 
be made with the same consistent font?

The Nordyke Twins Birth Certificates
For those that are not familiar with the story—flashback during the 
2008 election cycle, when questions were raised about Obama’s 
birth certificate. I believe it was the mother of the Nordyke twins 
who released an image of the birth certificates in an attempt to 
show an example of what a real 1961 Hawaiian birth certificate 
should look like. Fast forward, to 2011 when Obama releases a long 
form and the Nordyke image becomes even more significant in the 
discussion.

When viewing Obama’s document for the first time, one of the first 
items that struck me as odd (especially if still applying common 
sense) was the curvature on the left edge of the document. To 
make matters worse, I could see evidence that the poor quality text 
seems to be digitally manipulated to mimic the curvature. For me, 
the Nordyke image explains the inspiration for the curvature effect 
(and trust me, it is just that—an effect—even down to the shadow).

Furthermore, I believe the Nordyke image played a significant role 
in compiling Obama’s document and used as the ultimate template 
for the final product. 

Figure 13:  Nordyke certificate a possible template source?

Left margin consistent with typewriter

The offical seal 
can be seen

Date Accepted and filed

Certificate number 
and birth date

Figure 12:  Overall information defies common sense

A signature for a local registrar official 
would have that many initials? Really? 
U K L Lee—Ukulele? I know it’s Hawaii, 

but what are the odds?

Left margin inconsistencies

Odd comma spacing?

Negro was the 1961 
option—not African

Where’s the offical 
seal or stamp?

Date Accepted and filed

Certificate number fraud?

Different fonts?
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Photoshop and Illustrator Differences
Up until this point, the document has been viewed in Acrobat. 
However, when the file is opened in Illustrator, significant 
information is revealed. Keep in mind that I believe the certificate 
image was compiled and created in Photoshop, but the PDF file 
needs to be opened in Illustrator in order to view the embedded 
information within the PDF. Why Illustrator and not Photoshop? 
Stick with me while I explain the differences of both programs.

Photoshop v Illustrator
There are two different types of graphics: raster-based or vector-
based. Raster is merely a fancy word for pixels; therefore a raster-
based graphic is a pixel-based image. Photoshop is a raster-based 
program. All scanned images, digital camera photos, and most 
images seen on the web sites are pixel-based (raster) files. So what 
is vector?

As you might have guessed, Illustrator is a vector-based program. 
Vector implies math, thus every line drawn in Illustrator is a 
mathematical equation to the computer. Resizing a vector graphic 
means the program simply recalculates the math and the resulting 
image retains clarity. Why is this important? There are a couple 
of reasons. The vector capability of Illustrator is why embedded 
information in the PDF file can be viewed in Illustrator.

Whereas opening a PDF file in Photoshop would flatten and 
rasterize the file to convert the image to pixels—embedded 
information would not be seen. The main take away point is that 
just because you can see this PDF information in Illustrator does 
not necessarily mean the file was compiled or created in Illustrator.

Also the lack of clarity in the certificate items suggests it was a 
pixel-based file, not a vector-based file.

Figure 14 offers a comparison of raster vs. vector objects. An 
enlarged view of a sample area (from the full image shown) 
displays the pixel antialiasing edges when zoomed in at 1200%. 
The vector version is crisp even at a 6400% zoom level. There are 
no pixels—only a crisp clear edge line known as a path.

It is important to understand that you cannot convert a pixel image 
to a vector image simply by opening it in Illustrator. Unfortunately, 
it’s still pixel-based, but it can be opened and viewed in Illustrator.

Also important to consider is a disadvantage of pixel images when 
resizing. Enlarging an image in Photoshop, requires the program 
to decide (or guess) where to add pixels, and what color value to 
assign the added pixels. The result is a loss of clarity or blurriness. 
This is important to remember, because this would account for the 
lack of clarity for text elements in Obama’s certificate.

Figure 15 shows the original low resolution Nordyke image at 
normal zoom level (100%). The darkest pixel colors (to select the 
text) were isolated and resized to fit the size needed for Obama’s 
document. Notice the loss in clarity of text.

Figure 16 shows the resized Nordyke text on a layer above 
Obama’s final document. Zoom in to see the similarities of poor 
quality text when enlarged, compared to the poor quality text in 
Obama’s document (peaking from under the resized text). The idea 
is to demonstrate how a low resolution image will become soft and 
blurry when resized. Photoshop provides enhancing tools that can 
be used to help compensate for the loss of clarity, but the results 
will still be less than perfect when dealing with low resolution 
images.  

Figure 15:  Nordyke image text enlarged

Original low resolution 
image of the Nordyke file

File cleaned up slightly 
and resized to fit the higher 

resolution needed for 
Obama’s file

Both viewed at 100% 
to show size difference

Figure 16:  Enlarged Nordyke template set above Obama text

Nordyke template 
on layer above 

Obama PDF text

Enlarged text 
results are fuzzy 
and preliminary 

background removal 
leaves behind a slight 
pixel background halo

Sample window area

Pixel-based

Vector-based paths

Figure 14:  Pixel-based compared to a vector-based file

1200% zoom level

6400% zoom level
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Over Sharpening to Compensate
Based on how the text appears in the PDF document, it would be 
my guess that the user over sharpened poor resolution text in an 
attempt to achieve clarity. The problem with over sharpening is 
that Photoshop is looking for edges of contrast, and increasing 
contrast until eventually (in this case), the resulting pixels are either 
black or white—with no transitional pixel colors (for antialiasing). 
This would explain the clunky bitmapped jagged edges, the solid 
black text, and the white halo effect surrounding the text.

Figure 17 helps to illustrate how this might work. Step 1 in the 
Figure shows the Nordyke enlarged text without a background. 
Notice that the surrounding edges of the text are grayish in tone 
(remnant colors of the original image background). Step 2 shows a 
sharpening filter applied to the text using extreme settings. Notice 
the jagged bitmapped result (starting to look familiar?). Finally, 
Step 3 shows a green background applied to a layer below the 
text so you can easily see the pixel edges of the text. Notice the 
remnant gray pixels turned white (the white halo effect?).

The results in Figure 17 are not an exact duplicate since it’s 
impossible to know every step taken when creating the document, 
but this Figure does display a valid explanation for the quality 
of the text. Consider the clarity that would be present if the file 
had actually been scanned from an official document. Recall 
Figure 4 (on page 2) in which the scanned text example provides 
a significant amount of clarity. And if the document had been 
created digitally by typing text within a graphic program, the 
text would have been extremely clear and sharp (since typed 
text would most likely be vector). Thus the poor quality is also a 
strong indication of image compilation, and also provides another 
good argument against the OCR theory, since an OCR scan would 
convert the text to editable text, thus the text would be clear.

Layers
Think of Layers as analogous to transparencies used on a projector. 
If an image file is unedited, whether scanned, or transferred 
from a digital camera, the file will only have one flattened layer. 
In keeping with the transparency analogy, this would be like 
having the file printed on one transparency and showing it on 
the projector. When a portion of an image is selected and copied 
to a new layer, it would be like having that selected object on a 
separate transparency above the starting transparency image. This 
allows you to move the object around independently of the other 
surrounding layers (or transparencies).

Figure 18 shows a screen capture of an Excel file, focusing on the 
tab text (to demonstrate moving text around). The starting image 
shows one layer. The first four capital letters are in the wrong order 
in both image tab areas. The correct order for both tabs (in this 
example) should display the letters as RBGC. Figure 19 shows 
the copied letters moved into the proper position and the Layers 
panel shows each copied letter on a separate layer which makes 
repositioning easy to accomplish. Notice an additional layer was 
created for each tab and filled with the tab background color in 
areas of the affected original letter positions to keep the old letters 
from show through behind the new letter copies. In other words, 
part of a B might show through if behind the letter C. The block of 
gray or white tab color between the old letter and new letter solves 
the problem and leaves the original image intact.

Figure 17:  Effects of over sharpening a resized image

Original resized Nordyke text 
with gray surrounding pixels

After sharpen settings are applied

Smart Sharpen Filter 
using extreme settings

Checkerboard pattern 
in preview indicates 

transparent areas of layer

Green background added to layer 
below, Note the jagged text and 

white surrounding pixels

1

2

3

Figure 18:  Text letters on Excel screen capture will be moved

One layer

C & B positions need 
to be reversed

C & G positions need 
to be reversed

Figure 19:  Text manipulation via layers

C & B after positions 
are reversed

C & G after positions 
are reversed

Separate layers for gray tab manipulation

Separate layers for white tab manipulation



REPORT BARACK OBAMA: LONG FORM BIRTH CERTIFICATE	 Page 9 of 12

Obama’s Certificate PDF File in Illustrator
The previous page offered a crash course in layers, but the main 
idea is that they allow for the ability to manipulate or reposition 
objects separately within a document—emphasis on manipulate.

At first glance, when opening Obama’s PDF file in Illustrator, you 
may not notice any differences. Adobe programs offer many 
different panels—each with its own purpose. The two crucial 
panels that need to be open for this discussion are the Layers and 
Links panel as shown in Figure 20. This is where the fun begins. 
If playing along and you’re not familiar with these programs, all 
panels are toggled on or off via the Windows menu. So if you do 
not see these panels opened by default, just go to Windows and 
click each panel name to toggle each panel on as needed.

Layers and Clipping Masks
At first glance, the Layers panel appears to have only one layer, 
but the Layers panel in Illustrator varies slightly compared to the 
same panel in Photoshop. In Photoshop, the layer stacking order 
determines what object is on top or bottom. The same is true in 
Illustrator, but due to the vector nature of this program, you can 
also have an object layer order within each layer—sub-layers—in 
addition to multiple layers to determine order. Figure 20 shows 
where the toggle icon is located to collapse or expand the view 
of each layer. Click to expand the Layer as needed and a Group is 
revealed.

These groups are made up of the object and a clipping path, so 
what is a clipping path? Recall that in vector programs, the edge 
outline of each object is known as a path. When objects are pixel 
based, there are no paths to define each specific outline (for 
example, typed text is still pixels, not vector paths for the text), so 
the outside edge of each pixel object image becomes known as a 
Clipping Path. In other words, a path is generated for the outside 
boundary—where the object ends.

Additionally, all the individual objects import into Illustrator as one 
grouped object—the total composite image of this document. In 
order to have free movement of each individual layered object, 
they need to be ungrouped. Perform the following steps:

ÂÂ Press Ctrl+A to Select All (Mac users: Command+A).

ÂÂ Right-click inside the document image and click the option 
Release Clipping Mask (see Figure 20).

ÂÂ Repeat the above step a second time to release any sub-
grouping of objects.

ÂÂ On the Layers panel, click the Expand icon as necessary to 
reveal all sub-layer objects (see Figure 21).

Notice that each Group layer is made up of subgroups which 
consist of the clipping path (the edge boundary) and the actual 
pixel object (also seen in Figure 21). The first column in the Layers 
panel displays an eye icon which controls the visibility for each 
object. Simply click on this icon to toggle the visibility on or off. 
Figure 22 shows the visibility toggled off for the bottom group—
the background pattern. 

Also, try this, click the Selection Tool (shown in Figure 22), then 
click and drag on any of the grouped objects within the document 
to select it and move the selected object to a new location. Can 
you do this with any of the official documents you scan? At the 
risk of sounding like a broken record, this is not normal, unless the 
document has been compiled digitally.

Figure 20:  PDF file opened in Illustrator

Layers panel

Collapse or Expand icon

Release Clipping Mask

Window menu Links panel

Figure 22:  Visibility of Background layer pattern toggled off

Layer group visibility toggled off

Collapse or Expand icon

Clipping Mask path

Window menu Links panel

Selection Tool

Figure 21:  Objects displayed on the Links & Layers panel

Layer visibility icon

Collapse or Expand icon

Clipping Mask path

Links panel

Sub-Layer Group
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Figure 23:  Link Information for Onaka stamp object

Double-click to open 
Link Information dialog box

Scale Information: 
24% scale, Rotated -90°

Figure 24:  Link Information background pattern object

Background Link Information dialog box

Scale Information: 
48% scale, Rotated -90°

Similar to the Layers panel, the Links panel should only display 
one link (if this was a normally scanned image). Multiple links are 
also indicators of image manipulation since they reference objects 
added to the document (not part of the original document). 
Double-click any of the link items seen in the Links panel to display 
a Link Information dialog box (for additional information).

Figure 23 shows the Link Information for the Onaka stamp object. 
The important focus has to do with the scale information which 
shows the object was scaled 24% and rotated -90°. Most of the 
links show similar scale information except for the background 
pattern. Figure 24 shows the Link Information dialog box which 
indicates the background pattern object has been scaled at 48% 
(instead of 24%). Again, this inconsistency is another indicator of 
image manipulation that refutes the OCR naysayer argument. If 
the document is scanned, regardless of whether OCR software 
was used or not, there is still a consistency in the scanning process 
(which is not present in this document). Items will not scale at 
different sizes during a scan.

The OCR Argument Explored Further
OCR—which again stands for Optical Character Recognition—will 
scan a document for text and convert any images of text to live 
text which can be edited. The text responds as if you were in a 
Word document. The text can be selected, changed, copied and 
pasted. If the PDF had been scanned using OCR software (as many 
claim); the document would also be able to search for keywords. 
In other words, when opening the PDF file, you would be able to 
type in a keyword in the find dialog box and the document would 
recognize the word. This does not happen when opening Obama’s 
PDF file.

Additionally, the properties dialog box would reflect which fonts 
were used in the document. Figure 25a reflects the Font Properties 
dialog box in Obama’s PDF certificate file. This can be viewed by 
going to the File menu > Properties, then click on the Font tab in 
the Document Properties dialog box. As you can see, this dialog box 
is empty indicating that the PDF file does not recognize any text.

In contrast, fonts can be seen after the file was then processed 
through the OCR Text Recognition option in Acrobat (found 

on the Document menu). For 
anyone playing along, go to the 
Document menu and select OCR Text 
Recognition, and then click Recognize 
Text Using OCR. Acrobat will then 
perform a scan on the document and 
convert any text found in the image to 
editable text.

The Acrobat Find box is then able 
to locate and recognize words in the 
document, but more importantly, 
Figure 25b shows that all the fonts 
recognized during the process are now 
listed in the Font Properties dialog box. 
Interestingly enough, the file no longer 
shows multiple layers in Illustrator, 
which also contradicts the claims made 
by the naysayers.

Figure 25a:  Font Properties of PDF file

Document Font Properties 
of original PDF file

Document Font Properties 
after OCR Text Recognition

Figure 25b:  Font Properties dialog after OCR Text Recognition 
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Figure 26:  Excel capture with layers saved as a PSD file

Figure 27:  Default settings in Illustrator preserves PSD layers

Figure 28a:  The Links panel and Layers panel after opening

Click the Layers panel menu 
and choose Flatten Artwork

Saving the PSD (Photoshop) Layered File
As stated earlier in this report, it is my theory that the file was 
compiled and created in Photoshop, but some work might have 
been done in Illustrator as well. A Photoshop file (known as a PSD 
file) will preserve all the layers created (as long as the image hasn’t 
been flattened). The Excel capture used previously in the report 
(and seen in Figure 26) will be used again for the purposes of this 
next demonstration.

When the PSD file is opened in Illustrator a Photoshop Import 
Options dialog box displays as seen in Figure 27. The default 
settings will preserve the layers and convert them to an object 
which merely means that each pixel-based object will have the 
outer path to distinguish the boundaries of that object.

Figure 28a shows the opened PSD file in Illustrator. Notice the 
Links panel displays the layer objects as links (similar to Obama’s 
file), and the Layers panel displays the layers in the same order 
as the Photoshop counterpart seen in Figure 26. The process of 
flattening the document in Illustrator is also a similar process 
compared to Photoshop. The user would click on the Layers panel 
menu icon (see icon callout in Figure 28a) and click on the Flatten 
Artwork option. In Photoshop the menu option would be Flatten 
Image. 

While the process may be similar the results are not. When the 
document is flattened in Photoshop, it becomes one flattened 
layer in the traditional sense (as previously discussed). However, 
as Figure 28b shows, the Layers panel in Illustrator flattens the 7 
layers by placing all the objects into a separate sub-layer contained 
within one main layer. Recall that vector programs can contain sub-
layers. In addition, if the user were to select the entire document 
and then go to the Object menu to choose Clipping Mask > 
Make, the result is the opposite of the procedure used to release 
the clipping mask group. This will cause all the sub-layers to be 
converted to the groups also seen in Figure 28b.

When saving the file as a PDF from Illustrator, the default setting 
will Preserve Illustrator Editing Capabilities—which means it 
will retain all the object (sub-layer) information within the PDF file. 
Thus when the PDF file is opened, the layer and sub-layer groups 
are still available. There’s a very strong possibility that the creator of 
Obama’s certificate file followed a similar process.

Figure 28b:  The Layers panel before and after Flatten Artwork

7 Layers before flattening 1 Layer after flattening

Sub-layer groups
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